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Installation

Requirements

URL Manager Pro 3.3 requires Mac OS X 10.2 or higher. On Mac OS X 10.1 you can use URL Manager
Pro 3.1.1. URL Manager Pro 2.8 is still available for Mac OS 8 users. The bundle size of URL Manager
Pro 3.3 is around 8 MB, including this user manual and localizations for English, Japanese, German,
French, Spanish and Italian, which are all included in the default package.

Installing

Installation is very easy, just move URL Manager Pro into the Applications folder. To start using URL
Manager Pro, simply double-click the application icon.

Optional: You may want to install the Add Bookmark Contextual Menu Item plug-in. The Add Bookmark
plug-in can be installed using the URLs tab of the Preferences Window of URL Manager Pro. The plug-in
will then be copied to:

 ~/Library/Contextual Menu Items/

Where ~ is the customary Unix shorthand to indicate the user's home directory. For more information, go to
the Add Bookmark Web page or the Contextual Menu Item section in the Special Features chapter.

The Bookmark Menu Extra

While URL Manager Pro is running, it automatically adds the Bookmark Menu Extra to the menu bar. With
the Bookmark Menu Extra you have access to your bookmarks from within any application, including your
web browser. The Bookmark Menu Extra is located in the right part of your menu bar (see below).

- The Bookmark Menu Extra -

Using the Bookmark Menu Extra, you can add bookmarks, launch bookmarks, and easily open bookmark
files and switch between your bookmark files. With URL Manager Pro you store your bookmarks in
bookmark files that you can create and manage and have control over. You can organize and create several
bookmark files and have easy access to them via the Cabinet feature of URL Manager Pro.
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Installing Shared Menus (optional)

We prefer you use the Bookmark Menu Extra, but you may want to use the Shared Menus feature instead.
We prefer the Bookmark Menu Extra, because it is not likely to interfere with other programs and does not
involve installation of a separate component of software. The Shared Bookmark Menu is appended to right
of the Help menu of your web browser. As such, the Shared Bookmark Menu appears more in the middle
of your menu bar than the Bookmark Menu Extra. The chapter ‘Bookmark Menu’ of this manual explains
the difference between the Shared Menus and the Bookmark Menu Extra. In the screen shot below, you can
see the URL Manager Pro Shared Icon Menu and the Shared Bookmark Menu (also an icon menu).

– Shared Menus in Safari –

You can install Shared Menus using the Menu Extra tab of the Preferences Window. URL Manager Pro
will then install the Shared Menus Component in:

 ~/Library/Components/

Where ~ is the customary Unix shorthand to indicate the user's home directory. If the folder Components
does not yet exist, it will be created. (The picture below shows the file path of the Shared Menus
Component for a user with user name alco).

– The file path of the Shared Menus Component –

Many applications, like Eudora and Microsoft Internet Explorer support the Shared Menus Protocol, but
some do not, like Safari. You can make all applications Shared Menus aware, by installing my Shared
Menus Enhancer. The Shared Menus Enhancer (SME) is an APE module and can be downloaded from:

Shared Menus Enhancer web page: <http://www.url-manager.com/sme.html>

To remove the Shared Menus Component, you can again use the Menu Extra tab of the Preferences
Window or you can remove it manually. To take effect, you need to quit and launch your web browser.
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Where to store your bookmark files

We strongly advise you to store your bookmark files in a folder named Bookmarks in your Documents
folder. The Documents folder already exists and was created by the Mac OS. Please create a Bookmarks
folder in your Documents folder.

Furthermore, we suggest you create two folders in your Bookmarks folder. One named Cabinet and one
named Startup Items. Put all your bookmark files in the Cabinet folder. Then make an alias of your primary
bookmark file and put the alias in the Startup Items folder.

In the picture below, you can see how your hierarchy of bookmark files should look (in the case for a user
with user name alco):

– The paths of the Cabinet and Startup Items folders –

The URL Manager Pro folder includes a bookmark file called Sample. Sample contains a small collection
of bookmarks that we refer to in the tutorial Getting Started. These bookmarks will also be useful to help
you get started exploring the Web with URL Manager Pro.

Please move the file Sample to the Startup Items folder as defined in the above hierarchy when you want to
follow the Getting Started tutorial.
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User Manual

The User Manual is part of the URL Manager Pro package. You can choose the following commands from
the Help menu in URL Manager Pro:

• URL Manager Pro Help
• Shared Menus Help
• Keyboard Shortcuts
• User Manual

URL Manager Pro is an application
URL Manager Pro works with popular Internet applications, including Safari, Microsoft Internet Explorer,
OmniWeb, Firefox, Camino, Mozilla, Netscape, iCab and Opera. Because URL Manager Pro is not an
extension to your Internet applications, but a standalone program, it does not consume memory when you
are not using it.

URL Manager Pro is a Mach-O bundled application (Mac OS X native) and is localized in English,
Japanese, German, French, Italian and Spanish.
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Getting Started
Introduction
The Getting Started section contains a tutorial to help you get up to speed quickly using URL Manager Pro.
In this tutorial, you will be introduced to the following topics:

• Opening Web Pages
• Adding bookmarks to URL Manager Pro
• Organizing your bookmarks

The Sample file

To follow the tutorial, please locate the bookmark file Sample. You can find it in the URL Manager Pro
folder. Sample contains a collection of bookmarks.

Note: Bookmarks contain Universal Resource Locators (URLs), the format in which Internet addresses are
stored. A URL is represented in URL Manager Pro as a bookmark.

By exploring the sample collection of bookmarks, you will get a sense of the power and versatility of URL
Manager Pro. Naturally, as soon as you familiarize yourself with the way the program works, you will want
to start your own collection of bookmarks.

Opening Web Pages
You can open Web pages from bookmarks stored in URL Manager Pro in one of four ways. The first way
is by opening a bookmark from within URL Manager Pro. The second way is by using URL Manager Pro's
Bookmark Menu Extra or Shared Bookmark Menu feature for opening a Web page from within your web
browser. The third way is through the popup menu of URL Manager Pro’s icon in the Dock. A fourth way
is by using Drag & Drop. Each of these four approaches has advantages, which we describe below.

Opening a bookmark from URL Manager Pro
A good place to start learning how to use URL Manager Pro is by going to the URL Manager Pro Home
Page. URL Manager Pro is updated on a regular basis, and it is possible that there is a newer version
available than the one you have, particularly if you obtained your copy on CD-ROM. It is always a good
idea to use the latest version of URL Manager Pro.

Open the Sample file and look at the Tutorial folder, the top folder in the Sample document window. You
will find four bookmarks. Double-click the first bookmark, called URL Manager Pro's Home Page.
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If your Web browser isn't running, URL Manager Pro will launch it. If your browser is running, URL
Manager Pro will try to open this Web page in it. If you are not connected to the Internet, your Web
browser will alert you that it cannot make a network connection. In this case, you should start your PPP
dialer or whatever other programs you use to connect to the Internet.

If you are connected to the Internet, your Web browser should load the URL Manager Pro Home Page. It
may take several seconds to load completely. Once the URL Manager Pro Home Page is loaded, take a
moment to view the contents of this page. You'll find it offers links to many useful things, such as the latest
version of URL Manager Pro in various languages, documentation, support addresses, and the like.

To find out which version of URL Manager Pro you have, go to the URL Manager Pro menu and select
About URL Manager Pro... You will see a window that displays the version number.

If a later (that is, a higher-numbered) version of URL Manager Pro is available on our Web site, click on a
download link and you will be prompted to download it to your computer.

Once the file transfer has been completed, exit URL Manager Pro, open the file you downloaded, and
install the newer version of URL Manager Pro by replacing the application in the URL Manager Pro folder
with the newer version. Restart URL Manager Pro. You are now up-to-date!

We recommend you check the URL Manager Pro Web site regularly for new versions and additional useful
information about URL Manager Pro and our related products.

Opening Web pages from within URL Manager Pro is a good way to start surfing the Web. However, if
you have already opened your Web browser and have been surfing for some time, you may find it more
convenient to open a Web page from within your browser (provided you stored its bookmark in URL
Manager Pro). You will learn how to do that in the next section.

Opening a Web page from within your browser
URL Manager Pro can give you access to its bookmarks from within your browser in three different ways:
the Bookmark Menu Extra, the Bookmark Shared Menu and the Dock Menu.

The Bookmark Menu Extra shows all your bookmarks and is located in the Menu Extras or ‘menulets’ area
of the menu bar in Mac OS X. The Bookmark Menu Extra’s icon is the URL Manager Pro document icon
(left of ‘Wed’ in the picture below).

- The document icon menu at the left is the Bookmark Menu Extra -

If you click on the document icon menu, you will see that it lists all the folders and bookmarks in the
current open bookmark file. It also has a command to bookmark the current Web page.

The Bookmark Menu Extra is the preferred way of accessing and adding your bookmarks.

The Dock Menu appears when you Control-Click on the URL Manager Pro icon in the Mac OS X Dock.
Again you will see that the submenu Sample with the URL Manager Pro document icon shows all the
folders and bookmarks in the current open bookmark file (Sample in this example).



Tutorial

- 8 -

- Dock Menu -

Shared Menus are new menus appended to the menu bar of your Web browser and other Internet
applications. Called the URL Manager Pro Shared Icon Menu and URL Manager Pro Shared
Bookmark Menu, they contain a number of useful URL Manager Pro commands, which allow you to
control URL Manager Pro and the bookmarks you have saved in it from within your browser.

Below you see Safari's menu bar with URL Manager Pro's Shared Icon Menu and Sample Shared
Bookmark Menu installed. The menu Sample, right next to URL Manager Pro's Shared Icon Menu,
displays all bookmarks in your current open URL Manager Pro bookmark document. The name of the
menu is the name of the document, in this case Sample. (It is also possible to have a document icon
displayed instead of the document name. Choose Preferences from the URL Manager Pro Shared Icon
Menu and select the Appearance tab).

- The Shared Menus shown at work in Safari -

If you go to the Sample menu, you will see that it shows all the folders and subfolders in the Sample file.

If, for example, you select URL Manager Pro's Home Page from the Tutorial submenu, your Web
browser will open this page, provided you are connected to the Internet. Once you get used to using the
Shared Menus, you will find that it is a powerful feature of URL Manager Pro. The URL Manager Pro
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Shared Icon Menu and the Shared Bookmark Menu are explained in this user manual, but more specific
information is also available in the Shared Menus Help book.

Note: We prefer you use the Bookmark Menu Extra or the Dock Menu. Shared Menus are still fully
supported, however, mainly to support URL Manager Pro users coming from Mac OS 9.

Note: If you double-click the Contact the Author bookmark, your email program will launch. This is
because it is a different type of bookmark. It is a bookmark with the mailto: protocol. This feature of URL
Manager Pro is described in more detail later.

Open a Web page using Drag & Drop
Drag & Drop is a powerful feature of the Mac operating system. It allows you to drag icons and other
objects from one program to another. This is very useful for opening Web pages for which you’ve stored
bookmarks in URL Manager Pro. To open a Web page using Drag & Drop, you will need to make both
your browser and the URL Manager Pro windows visible. On a large monitor, this shouldn't be difficult; on
a PowerBook, one window may have to slightly overlap the other.

Activate the URL Manager Pro bookmark window by clicking on its window title bar. Open a folder by
double-clicking on it or clicking the disclosure triangle. For example, open the Magazines folder.

Select, for example, the MacWorld bookmark icon.

Now, press and hold the mouse button.

While you are doing this, move the cursor over to the exposed part of your browser window—you will see
an outline of the icon as you drag it. This is to let you know that Drag & Drop is functioning.

When your mouse cursor is over the browser window, release the mouse button. You have now "dropped"
this icon in your browser. Your browser will open the MacWorld home page, provided you have an active
Internet connection.

You can explore the other bookmarks in the Sample document at your leisure, either by opening them from
within URL Manager Pro or by means of Drag & Drop. We have supplied a collection that we think may
be of interest to Mac users. However, you will probably want to start developing a collection of your own
URLs right away. You will learn how to add URLs to URL Manager Pro in the next section.

Adding bookmarks to URL Manager Pro
You can add bookmarks to URL Manager Pro in four different ways. 1) Add bookmarks directly within the
URL Manager Pro program. 2) Use the Bookmark Menu Extra, the URL Manager Pro Shared Icon Menu
or Dock Menu. 3) Use Drag & Drop. 4) Import the bookmarks file from your Web browser. Each of these
four approaches has advantages and is described below.

Adding bookmarks directly in URL Manager Pro
If URL Manager Pro isn't already running, open the URL Manager Pro folder and click on the URL
Manager Pro icon to start the program.

As before, you will be presented with the default URL Manager Pro document called Sample.

Let's say you would like to create a bookmark for ‘The Wall Street Journal’.

Select the bookmark "Contact the author".
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Go to the Bookmark menu.

Select the command New Bookmark.

This will create a blank bookmark icon in the Sample document called Untitled. Note that the new
bookmark appears after the selection.

- Creating a new untitled bookmark -

You’ll see that the label field next to the icon is highlighted—this is URL Manager Pro's way of prompting
you to give it a name right away.

Type in: The Wall Street Journal.

Press Tab.

Now the URL field is highlighted. For the time being, ignore the string of letters http:// in this field. This is
part of the Internet's URL addressing scheme. It indicates that the address is a Web page. (This is the URL
Manager Pro default.)

Click the mouse cursor to the right of http:// and type: www.wsj.com

Press Enter when you are done. The new icon is now called "The Wall Street Journal".

Make sure that you typed the URL correctly and that there are no spaces. If there are any spaces, URL
Manager Pro will not be able to open the page.

Now double-click on the new The Wall Street Journal icon. Your Web browser will open The Wall Street
Journal Web page, provided you have an active Internet connection.

You will find this technique for entering a bookmark directly in URL Manager Pro useful for adding a
bookmark you find listed in a magazine or newspaper or another source other than your computer. For a
bookmark you discover when surfing the Internet, there is a better way of adding it to URL Manager Pro.

At this point, now that you have started customizing your collection of bookmarks, you may want to give it
a more meaningful name. Let's rename the Sample document.

Go to the File menu.

Select Save As... You will be prompted to give it another name (the name of the current document, Sample,
is listed as default).
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Type in a suitable name, such as: My Bookmarks

The Save As window will look something like this:

- The Save As Window -

Use the popup menu next to the Where: label. Select Documents from that popup menu to make the
Documents directory the current directory.

Use the downward pointing triangle button to expand the window.

Click the New Folder button. Enter the folder name Bookmarks. Now save your new file in this new
folder.

Sample has now been renamed My Bookmarks and is saved in the folder ~/Documents/Bookmarks/ on
your hard disk.

Tip: To have a bookmark file open automatically each time you launch URL Manager Pro, open
Preferences and use the button Select Startup Bookmark File...

Note: To have multiple bookmark files open automatically each time you launch URL Manager Pro, put
these files into a folder named Startup Items in the ~/Documents/Bookmarks/ folder. In addition, you may
want to drag the Sample document out of Startup Items so that it will not be loaded at startup. Put it in the
Cabinet folder instead. You can easily open documents in the Cabinet folder from within URL Manager
Pro via the Quick Open menu command under the File menu. You can also use the Cabinet toolbar item
for quick access to your bookmark files (see below).
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- The Cabinet toolbar item shows the bookmark files in the Cabinet -

Furthermore, documents in the Cabinet folder are listed in the Cabinet submenu of the Bookmark Menu
Extra, URL Manager Pro Shared Icon Menu and the Dock Menu. This means you can open your bookmark
files right from within your browser!

Below you can see the preferred hierarchy of storing your bookmark documents.

- The file paths of the Cabinet and Startup Items folders visually shown -

Note: You may use aliases for the Startup Items and Cabinet folders, and the bookmarks files may also be
aliases. The Cabinet and Startup Items folders are more fully explained in the Special Features section of
the User’s Manual Reference section.

Adding Bookmarks to URL Manager Pro from within your browser

First, switch to your browser.

Let's say you are on a Web page that you would like to save as a bookmark in URL Manager Pro—for
example: http://www.washingtonpost.com. (For the purposes of this tutorial, open the home
page of this well-known newspaper in your Web browser.)

If you use the Bookmark Menu Extra, click the document icon menu and select the command Add
Bookmark.... If you use Shared Menus, go to the Sample or My Bookmarks Shared Menu and select the
first command, Add Bookmark.... If you use the Dock Menu, Control-Click the URL Manager Pro icon in
the Dock and select the command Add Bookmark....

The Add Bookmark Window will appear (see next page). By default, the title of the Web page is
displayed as the name of the bookmark, but you can enter any text you wish. In this case, the default is
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"washingtonpost.com – nation, world, technology and Washington" Let's rename it simply: Washington
Post.

In the empty box underneath, the note field, you can enter a description of this Web page. This is useful for
keeping pertinent information about this page. Let's add a note, for example: Washington DC daily.

- Add Bookmark Window -

Tip: At the time you create a bookmark, you may think that the contents of a Web page are obvious from
its name or URL, and that it is unnecessary to fill in a note. However, after using URL Manager Pro for a
while, most people find that they have a very large and continually growing collection of bookmarks. After
a while, you may have a hard time finding a bookmark you saved in the past or remembering why you
saved a bookmark. This is particularly true in the case of a URL buried deep within a Web site. If you add a
one- or two-line note at the time you save a URL, your bookmarks will be easier to manage, and you will
more easily be able to find a bookmark again.

Click the Add button and this bookmark will now be added to URL Manager Pro.

Please switch to URL Manager Pro. Look for the Drop Basket folder. New bookmarks you add using the
Add Bookmark command are stored by default in the Drop Basket folder. If a Drop Basket folder does not
yet exist, it is created automatically. However, as you can see in the picture above, by using the folder
popup menu you can specify another destination folder if you want to.

In the Drop Basket folder you will find an icon called "Washington Post".
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- The Drop Basket is always shown in red -

To the left of the title, you will see the bookmark icon. If you added a note for this bookmark, you’ll see the
Clipboard icon directly to the left of the URL. This serves as a reminder that there is a note attached to the
bookmark. Move over it with the mouse and the note will appear in a tool tip.

- A bookmark note shown in a tool tip -

To view and edit the bookmark, go to the Bookmark menu and select Get Info. The Get Info window will
appear, showing information about the bookmark, including the Name, URL, and Note field, and several
advanced options.

Note: You can modify the name and note if you wish, but we recommend you do not change the URL. If so
much as one letter is changed to be incorrect, you will be unable to reopen this Web page.

For the moment, you can leave your new bookmarks in the Drop Basket, but in most cases, you will
eventually want to move items in the Drop Basket to other folders, depending on how you want to sort your
bookmarks. In some cases, however, you may already know which folder you would like to save a
bookmark to. In the next section, you will learn how to save a bookmark directly into a specific folder.

Adding a Bookmark using the Bookmark Menu Extra or Shared Menu
In this section, we will create a new folder and save a bookmark directly into the new folder.

First, switch to URL Manager Pro.

Go to the Bookmark menu and select the command New Folder.

At the bottom of the window, a new folder will appear called Empty Folder. You’ll see its label is
highlighted—you’ll want to give it a more distinctive name. (If you select a bookmark or folder first, the
new folder will be created just under the selection.)

Let's call it "Newspapers".

Now, go back to your browser.

If you don't already have an active Internet connection, open one.

Go to the Washington Post Web site: http://www.washingtonpost.com. It is sufficient to only type
'washingtonpost' in the browser's Location field.

In the previous exercise, you saved the bookmark of this site to the Drop Basket. But let's say that you
would prefer to save this bookmark into a different folder, one you have already created for this kind of
site.
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If you look at the right of your menu bar, you will see the Bookmark Menu Extra. If you use Shared
Menus, look at the menu bar and next right to the URL Manager Pro Shared Icon Menu, you will see a
menu called Sample or My Bookmarks. These bookmarks menus will show all your bookmarks in the
current open URL Manager Pro document.

Go the Newspapers submenu. You will see just one command displayed, Add Bookmark.... Select this
command.

The Add Bookmark Window will appear. By default, the title of the Web page is displayed as the name of
the bookmark, but you can enter any text you wish.

Let's rename it simply to Washington Post.

In the empty box underneath, you can enter a description of this Web page. This is useful for keeping
pertinent information about this page and helping you remember its contents.

Let's add a note, for example: A Washington DC daily newspaper

Click the Add button.

Switch back to URL Manager Pro using the Command-U shortcut of the URL Manager Pro Icon menu. If
you use the Bookmark Menu Extra, you can also use the shortcut Option-Command-U (please enable this
hotkey via the Preferences Window of URL Manager Pro).

If you open the Newspapers folder icon by double-clicking it, you will see the bookmark you just saved
located here. It will have a Clipboard icon to the right of the bookmark, reminding you that there is a note
attached to it. You will find the ability to save a bookmark to a specific folder extremely useful when you
are collecting bookmarks of a similar type, such as the Web sites of newspapers, for example.

Most of the time, you will find that you save bookmarks to URL Manager Pro either by means of the Add
Bookmark command of the Bookmark Menu Extra or Shared Bookmark Menu or, as in the above example,
the Add Bookmark command in a submenu. However, if you have been surfing the Web for a while
without URL Manager Pro, you may have built up a substantial collection of bookmarks in your Web
browser. Wouldn't it be nice to move this collection into URL Manager Pro? In the next section, you will
learn how to do this.

Importing bookmarks to URL Manager Pro
URL Manager Pro allows you to import bookmarks created in Safari, Internet Explorer, Netscape, Firefox,
Mozilla, OmniWeb, Camino and iCab.

Select your browser from the Get from Browser submenu under the File menu.

URL Manager Pro will import your browser's bookmark file and open it as a separate URL Manager Pro
document. It will have the same title as the browser bookmark file.

You now have two URL Manager Pro document windows open. At this point, you may want to move the
imported bookmarks into your main document, Sample, or whatever you may have renamed it.

You can copy bookmarks one by one, move a few at a time, or move them all at once.

To copy one bookmark from the import file, select its icon with the mouse cursor and drag it to the target
document, i.e. Sample.
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The icon of this bookmark will be added to the existing collection.

To copy a selection of bookmarks from the import file, proceed as follows.

Select an icon with the mouse cursor.

Press the Command key ( ) and hold it down.

Select as many other icons as you wish. The icons you select will be highlighted.

Now drag the selection to the target document, i.e. Sample.

The icons of these bookmarks will be added to the existing collection.

Note: To select multiple bookmarks that are in a row, you can also use the Shift key or use Drag-select to
make your selections.

To copy all the bookmarks from the import file:

Go to the Edit menu and select the command Select All.

Now drag the selection to the target document, i.e. Sample.

All of the icons in the import file will be added to the existing collection.

You now are familiar with the basic techniques of adding bookmarks to URL Manager Pro and opening
bookmarks saved in URL Manager Pro. In the next section, we will start to explore some of URL Manager
Pro's sophisticated features for organizing your bookmarks. This is where you will discover some of the
important advantages of storing your bookmarks in URL Manager Pro rather than in your Web browser’s
bookmarks menu.

Organizing your bookmarks
In this section, you are going to acquire some basic skills that will help you organize your bookmarks. You
will learn how to create, copy, and delete bookmarks. You will also learn how to search for a bookmark.

In the previous examples, you learned how to create an untitled bookmark using the New Bookmark
command in the Bookmark menu. You also learned how to create a new folder using the New Folder
command in the Bookmark menu, and how to add bookmarks to it. Now you will create a folder within a
folder, called a subfolder, and copy a bookmark to it.

Let's use the example we used above. Open the Newspapers folder. It will contain the bookmark for the
Washington Post Web site.

Select the Washington Post icon to highlight it.

Go to the Bookmark menu and select New Folder.
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A new folder will now appear. By default, its name is Empty Folder. The title field is highlighted so that
you can give it a more meaningful name. Let's call it: Washington DC Newspapers. Press the Enter
key to save this name.

Now select the Washington Post icon with your mouse button. Keeping the mouse button depressed, drag
this icon on top of the Washington DC Newspapers folder icon.

Now double-click the Washington DC Newspapers folder to open it. The Washington Post icon will be in
this folder. Double-click the folder again to close it.

By using subfolders, you can manage large collections of bookmarks much more easily. Say, for example,
you are developing a large collection of newspaper Web site bookmarks. By arranging them in subfolders,
such as by city, state/province, and/or country, you will find it much easier to manage your collection as it
grows.

In the above example, you moved a bookmark from one folder to another. Sometimes, you will want to
create a duplicate copy of a bookmark. You can do this in several ways.

Say, for example, you would like to create a duplicate copy of a bookmark in the same folder.

Let's try this by going to the Tutorial folder.

Open it by double-clicking it.

Select URL Manager Pro's Home Page icon to highlight it.

Press the Option key and start dragging the icon.

Move the icon below the email icon of the last bookmark in the folder and release. A copy of the bookmark
will appear.

Note the underline that the program draws (see below) as you move the icon over different bookmarks. It
tells you where the bookmark will appear in your list should you let go of the mouse button.

- Organizing bookmarks by drag and drop -

In most cases, you won't find it useful to have two identical bookmarks in the same folder. But maybe you
would like to place the same bookmark in a different folder.
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For example, you might want to have a link to the URL Manager Pro Web site in your Macintosh Links
folder. In this case, click on the icon of the duplicate bookmark, hold down the mouse button, and drag and
drop it to that folder. You now have the same bookmark in two locations.

While you will probably find it a little easier to manage your bookmarks if you keep only a single copy of
each bookmark, it may be useful to have duplicate bookmarks in some cases. For example, you may want
to keep a copy of the bookmark for the Netscape Web site in both your Mac applications and Internet
folders. Or you may want to keep Yahoo in both your News and Search folders.

You can also delete bookmarks you don't need anymore. Let's delete the duplicate bookmark we just
created.

Open the Macintosh Links folder.

Select the URL Manager Pro icon.

Press the Backspace key to delete this bookmark.

Tip: To delete multiple bookmarks, select them all and then press the Backspace key.

There are times when you will want to find a bookmark quickly without opening folders. To do this, you
can use URL Manager Pro's Search or Find function. Use the Search function to see all search results at
once and use the Find function to step through a Find step-by step. To use Search, choose Search from the
Edit menu. A drawer window will show with a search bar (see below). Enter the text you want to find in the
search bar and press return.

- The Search Drawer with Search bar -

To experiment with the Find feature, go to the Edit menu and select Find.

The Find Window box will appear. Enter the text you want to search for in the Find field, which is
highlighted.
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For example, enter: Dilbert

Press the Find button.

The Find function locates a bookmark that contains the text "Dilbert" in the More Magazines folder. Press
the Cancel button to close the Find dialog box. You’ll see that this bookmark is highlighted.

If you would like to continue the search, select the Find Again command (Command-G) from the Edit
menu. The Find function will search for another bookmark with the same text.

In this case, URL Manager Pro will beep because this is the only bookmark containing the text "Dilbert".

Close the More Magazines folder.

The URL Manager Pro Find function also searches the notes attached to bookmarks.

For example, select Find and enter: daily

URL Manager Pro will find this text in the Washington Post bookmark you entered earlier. It will display
the Get Info dialog box so that you can view the Note field containing this text.

Press Enter to close the Get Info Window.

Tip: As you can see, by adding meaningful information to a bookmark’s Note field, you make it easier to
find bookmarks again. This becomes useful when you have a large collection of bookmarks.

While the majority of bookmarks you collect in URL Manager Pro will be bookmarks of Web pages, URL
Manager Pro also allows you to store bookmarks for other kinds of Internet addresses. In the next and final
part of this tutorial, you will learn how URL Manager Pro handles email addresses.

Using URL Manager Pro with your email program
URL Manager Pro interacts with your email program similarly to the way it interacts with your Web
browser. For URL Manager Pro, an email address is, in fact, just one of several types of bookmarks that it
recognizes. The chief difference between an email address bookmark and a Web page bookmark is that
when you give URL Manager Pro the command to open an email address, it passes this command to your
email program, not to your Web browser.

For example, open the Tutorial folder.

Inside you will see an icon called "Contact the Author". It has a different icon than the URL Manager Pro
Home Page icon. This is because it is an email address bookmark.

Double-click on this icon. It will launch your email program if it is not running. If it is running, it will open
a new message window with this address in the To: field.

Note: By default, URL Manager Pro is configured to recognize Eudora as your email program. If you want
to change that configuration, open Preferences and click the Internet tab.

As in the case of your Web browser, URL Manager Pro also adds Shared Menus to your email program.
This means you can save email address bookmarks to URL Manager Pro from within your email program.
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Note: If you want to access Shared Menus in applications other than Web browsers, you must turn off the
preference Show Shared Menus only in Web Browsers, which is located under the URL Manager Pro Icon
menu’s preferences.

Open a message window in your email program.

Select the text containing the email address (see below for an example).

Choose the Add Bookmark... command from the Bookmark Menu Extra or Shared URL Manager Pro
Icon Menu.

Alternatively, you can use the Grab All command under the URL Manager Pro File menu to extract all
email addresses from a message. Although you can easily store your Web page bookmarks and your email
addresses in the respective bookmarks and address books of your browser and email program, you may find
it ultimately more convenient and secure to store all your bookmarks, email addresses, and the like in one
central location: URL Manager Pro. This makes it easier to move from one browser or email program to
another, even from one computer to another. Furthermore, URL Manager Pro is especially adept at helping
you manage large collections of bookmarks.

This concludes the Getting Started with URL Manager Pro tutorial. By now, you are acquainted with the
main features of URL Manager Pro. You can explore the program further on your own or use the Reference
section to learn more about additional specific features.
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Keyboard Shortcuts
The table below is an overview of shortcuts that do not appear in URL Manager Pro's menus.

Shared Bookmark Menu / Global Menu

Cmd-menu item Open bookmark in a new tab*

Cmd-menu item Invert the Open in new window preference

Ctrl-menu item Copy URL of bookmark to clipboard

 

*Safari Enable the preferences: in General: ‘Open links from applications in the current
window’ and in Tabs: ‘Tabbed Browsing and Select new tabs as they are created’

*iCab No need to enable any preferences

 

Bookmark Window

Cmd-← or delete Delete the selected bookmark

Ctrl-click Show the Contextual Menu

↑↓ Select previous/next bookmark

escape Cancel the current selection

enter, return, tab Edit the selected bookmark

tab While in edit mode, switch between name and URL for editing

Option-return Create a new bookmark

Cmd-↓ Open selected bookmark in browser

Cmd - → Expand the selected folder

Cmd - ← Collapse the selected folder

Cmd – Option - → Expand the selected folder and its subfolders

Cmd – Option - ← Collapse the selected folder and its subfolders

dragging Dragging bookmarks within a bookmark window moves them

Option - dragging Option-dragging bookmarks within a bookmark window copies them

drag (1) Drag and drop a bookmark to a text editor to insert the URL of the bookmark in the
text

drag (2) Drag and drop a bookmark to a Finder window to create an Internet Location File

drag (3) Drag and drop a bookmark to a browser window to open the bookmark

Option - drag Option-drag and drop a bookmark to a text editor (for example, BBEdit) to put the
bookmark in an HTML tag*
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Close box-Option-
click

Close all windows

Close box-Ctrl-
click

Discard all changes and close window

 

*HTML tag For example: <a href="http://www.url-manager.com">Home Page</a>

 

Get Info Window

Cmd-↓ Display enclosed bookmarks

Cmd-↑ Display enclosing folder

Cmd-N Display next bookmark

Cmd-P Display previous bookmark

 

Global Menu Icon

Option-click Switch to URL Manager Pro

 

Global Hot Keys*

Cmd-Option-U Switch to URL Manager Pro

Cmd-Ctrl-. Select next bookmark file

Cmd-Shift-D Add Bookmark Global Menu

 

*Global Hot Keys You must first enable these under URL Manager Pro's Miscellaneous preferences tab.

 

Other

page down Scrolls down by one page

page up Scrolls up by one page

home/end Scrolls to the beginning or end of the page, respectively

Cmd-. Stops validating

Cmd-. or escape Cancels most of URL Manager Pro's modal windows and panels
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